NOTICE

The information in this document is subject to change without notice and should not be construed as a commitment by ABB. ABB assumes no responsibility for any errors that may appear in this document.

In no event shall ABB be liable for direct, indirect, special, incidental or consequential damages of any nature or kind arising from the use of this document, nor shall ABB be liable for incidental or consequential damages arising from use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from ABB, and the contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

The software described in this document is furnished under a license and may be used, copied, or disclosed only in accordance with the terms of such license.

TRADEMARKS

Microsoft, Windows, Excel and Visio are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. All other trademarks are the property of their respective owners.

COPYRIGHT

Copyright © 2017 Limited. All Rights Reserved.

Revision: 1.0
Published: April 2017
Software: ProvueDB.Net Desktop Edition
Version: 3.2

SUPPORT INFORMATION

This program is developed, maintained and supported by PEL Support Services, ABB. We run a Hotline telephone and email service to answer any queries about ProvueDB.Net.

Please let us have any suggestions on how you feel we could improve ProvueDB.Net. You can contact us by any of the following routes:

By Telephone: +44 (0)1925 74 1126 By Post: PEL Support Services ABB Limited. Daresbury Park Daresbury Warrington Cheshire WA4 4BT United Kingdom.

By Fax: +44 (0)1925 74 1265

By email: pel.support@gb.abb.com
Contents

Preface ......................................................................... 1
  About this guide ................................................................. 1
  Who should read this guide ............................................... 1
  What is in this guide .......................................................... 1
  How this guide is structured ............................................... 1
  Conventions .................................................................. 2

Chapter 1 – Introduction .................................................. 3
  Database structure .............................................................. 3
  Overview of PEL ............................................................... 4

Chapter 2 – Getting started ............................................. 5
  Starting ProvueDB.Net Desktop Edition ................................ 5
    Starting ProvueDB.Net Desktop Edition............................. 5
  Quitting ProvueDB.Net ....................................................... 6
  Client interface – datasheets .............................................. 7
    Navigation pane – controls ............................................... 7
    Status tab .................................................................. 8
    Find tab ................................................................... 9
    Tools tab .................................................................. 10
    Datasheet tab ............................................................... 10
  Client interface – equipment lists ...................................... 11
  User assistance ............................................................... 12
    Online help ................................................................ 12
    Online documentation .................................................. 12
    PEL Support Services ................................................... 12

Chapter 3 – ProvueDB.Net Quick Tour ................................ 13
  Part 1 – Datasheets ......................................................... 13
  Part 2 – Equipment Lists .................................................. 15

Chapter 4 – Understanding datasheets ............................... 19
  Example common datasheets ............................................ 19
    Design basis sheet ........................................................ 20
    Process data ................................................................ 21
    Mechanical data .......................................................... 22
    Miscellaneous sheet ...................................................... 23
    Sketch sheet ............................................................... 24

Chapter 5 – Workflow and approval cycle ........................... 25
  Datasheet workflow ........................................................ 25
  Equipment ownership ...................................................... 27
  Using groups ................................................................. 27
  The approval process ...................................................... 27
Chapter 6 – Managing datasheets ..............................................29
    Managing equipment items ..................................................29
    Adding new equipment ......................................................29
    Renaming equipment ........................................................30
    Replicating equipment ......................................................30
    Deleting equipment ..........................................................31
    Creating datasheets ..........................................................31
    Adding a datasheet ............................................................31
    Opening an existing datasheet ..............................................31
    Copying a datasheet ..........................................................32
    Closing a datasheet ..........................................................32
    Deleting a datasheet ..........................................................32
    Managing other document types ..........................................33
    Adding a calculation or reference sheet ..................................33
    Renaming, Replicating or Deleting a document .......................34
    Viewing status overview ....................................................34

Chapter 7 – Working with datasheets ........................................35
    Datasheet workflow commands ............................................35
    Fetching an item for editing .................................................35
    Transferring an item .........................................................36
    Signing off an item of equipment ........................................36
    Checking an item of equipment ...........................................36
    Approving an item of equipment for issue ...............................37
    Entering and editing data fields ..........................................37
    Entering data fields ...........................................................37
    Converting units and values .................................................38
    Entering data fields involving a calculation ..............................38
    Viewing previous versions of data fields ..................................38
    Text processing in ProvueDB.Net ..........................................39
    Entering a description field in text mode ................................39
    Uploading a description field from Word .................................39
    Downloading the Word description file ................................39
    Adding sketches to a datasheet ............................................40
    Uploading the sketch files ..................................................40
    Downloading the current sketch files ....................................41
    Clearing the current sketch files ..........................................41
    Attaching files to a calculation or reference sheet ....................41
    Uploading calculation files .................................................42
    Downloading an attachment file ..........................................42
    Deleting an attachment file ...............................................42
    Linking datasheets ............................................................43
    Adding a link between datasheets ........................................43
    Managing datasheet links ..................................................43
    Printing datasheets ...........................................................44
    Printing a single datasheet ................................................44
    Printing all datasheets ......................................................44

Chapter 8 – Managing equipment lists .......................................45
    Managing equipment list specifications ..................................45
    Creating a specification ......................................................45
    Opening and/or editing an existing specification .......................46
    Renaming a specification ...................................................46
    Copying a specification .......................................................46
    Publishing a specification ...................................................47
    Deleting a specification .....................................................47
    Using an equipment list spreadsheet ......................................47
    Creating equipment from an equipment list .............................48
Contents

Reporting on equipment items from an equipment list.................................48

Chapter 9 – Administrator facilities..............................................................51
  Activating Project Administrator (PJA) privileges........................................51
  Defining the units for datasheets .............................................................52
  Managing users.........................................................................................53
    Listing users .........................................................................................53
    Adding a user .......................................................................................53
    Modifying a user ..................................................................................54
    Deleting a user .....................................................................................55
  Managing projects and plants ......................................................................55
    Creating a new project/plant ....................................................................55
    Renaming a project/plant .......................................................................56
    Deleting a project/plant .........................................................................56
  Copying data between databases ..................................................................57
  Clearing equipment locks ...........................................................................58
  Changing the equipment revision sequence ...............................................58
  Customising the datasheet logo ..................................................................59
  Hiding datasheets ......................................................................................59

Revision history .............................................................................................61

Glossary ..........................................................................................................63

Index .............................................................................................................65
Preface

Welcome to ProvueDB.Net Desktop Edition, the database management system that makes datasheet production fast, simple and productive. It provides access to over one hundred predesigned datasheets, or you can use your own.

About this guide

This guide is designed to assist you in becoming quickly familiar with the capabilities of ProvueDB.Net Desktop Edition, its interfaces and how the system is used.

Who should read this guide

This guide is written for users of ProvueDB.Net to help you take full advantage of its datasheet management tools. If you are new to this product, we recommend that you first read The 60 Second Guide to ProvueDB.Net Desktop Edition (Parts 1 and 2).

The guide assumes you are familiar with the Windows operating system. If you are new to Windows, you can find help, tutorials and support information by clicking Start > Help and Support.

What is in this guide


How this guide is structured

The chapters are organised as follows:

1. Introduction
   Introduces the product, outlining the database.

2. Getting started
   Shows how to start ProvueDB.Net Desktop Edition, introducing the client interfaces for the two main parts of the application – datasheets and equipment lists.

3. ProvueDB.Net Quick Tour
   Tutorials for typical session using the two parts of ProvueDB.Net, emphasising the commonly used features.

4. Understanding datasheets
   Shows typical examples of the most common types of datasheets.

5. Workflow and approval cycle
   Describes the workflow in developing datasheets, explaining how ownership of datasheets works and how groups can be
used to restrict facilities to particular user roles.

6. Managing datasheets Shows how to add equipment items and datasheets for your project or plant.

7. Working with datasheets Describes the workflow commands for developing datasheets, tells you how to enter data, attach graphics and notes to datasheets, print datasheets and export datasheets to Excel.

8. Managing equipment lists Describes how to use the Equipment Lists part of the application.

9. Administrator facilities Information for a Project Administrator

The guide also includes a glossary.

Conventions
The following typographical conventions are used in this guide:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>To help with procedures, items that you click, select, or view may appear with the bold format (buttons, options, and window titles, for example).</td>
</tr>
<tr>
<td><em>Italic</em></td>
<td>Proper names (software products, for example) and titles appear in the italic format.</td>
</tr>
<tr>
<td>Monospace</td>
<td>Represents any text that appears on the computer screen or text that you should type. It is also used for filenames, functions, and examples.</td>
</tr>
<tr>
<td><strong>Monospace oblique</strong></td>
<td>Represents variable text where you would type in a specific value.</td>
</tr>
<tr>
<td>&gt;</td>
<td>The chevron indicates a menu option in a procedure. For example, click File &gt; Open, means “on the File menu, click Open.”</td>
</tr>
</tbody>
</table>
Chapter 1 – Introduction

The ProvueDB.Net system allows the storage, retrieval and transfer of process engineering design data. The system ensures that your process data is accessible and controlled at all times. The system manages revision control and enforces checking and approval to ensure that everyone is working from the same, up to date revision.

Database structure

As the main purpose of ProvueDB.Net is the storage, retrieval and presentation of design data, it is important to understand the structure of the database to get the full advantage of the features. This structure is applicable to new plant design as well as modification to existing plants.

Projects can comprise a number of Plants and Plants can also comprise a number of Projects, as shown below.

The elements in the structure are as follows:

- **Projects**: All database information is stored under this Project name or number. The Project can comprise a number of Plants or vice-versa.
- **Plants**: The plants are chemical plants (or sections of plants) to which the data refers, for example, Ammonia IV or Purification station.
- **Equipment Types**: These are the physical equipment types, such as pumps, valves and actuators.
- **Equipment Instances**: These are the individual items of equipment making up the plant. Each item is defined by a unique identifier (name).
Datasheets

A set of datasheets are created for each item. The range of datasheets depend on the equipment type. Common datasheets include Design Basis, Sketch, Process and Mechanical.

Overview of PEL

PEL is a collection of tools to enable process engineers to carry out their day-to-day tasks more quickly and reliably. The software includes purpose built programs to generate datasheets, perform engineering calculations of liquid and/or gas flow, investigate physical properties and create fault tree diagrams. Designed by engineers for engineers, the tools are intuitive and easy to use. They can be used to work out every day calculations, for troubleshooting issues such as bottlenecks, or when making plant modifications. This low cost solution will enable engineers to design processes more quickly and reliably with up-to-date and permanently available design data.

Benefits

- Allows engineers to be more efficient and productive. With fewer manual calculations to do, tasks are carried out quicker;
- Improves QA and standardises procedures, through everyone using same set of data and calculations;
- Human errors in calculations are reduced;
- Improves production as bottlenecks can be identified quickly so a solution can be sought;
- Allows operators to get the best out of their existing assets by carrying out modifications rather than designing new ones.
Chapter 2 – Getting started

This chapter shows you how to start ProvueDB.Net Desktop Edition and introduces the client interfaces for the two main parts of the application – datasheets and equipment lists.

Starting ProvueDB.Net Desktop Edition

The most common way of starting ProvueDB.Net Desktop Edition is from the Windows Start menu, but you can also run it from a desktop shortcut.

ProvueDB.Net Desktop Edition uses a SQLite database to hold the datasheets you create. The database for you to use may appear in the list of databases when you start the program. Otherwise you can load an existing database or create a new one.

Starting ProvueDB.Net Desktop Edition

To start ProvueDB:

1) Click Start > All Programs > PEL > ProvueDB > ProvueDB.Net Desktop Edition.

   If using the classic Start menu or earlier versions of Windows, click Start > Programs...

   The Authorised Databases window appears.

   ![Authorised Databases Window]

   2) In the top pane, select the database you want.
3) Enter your user name and password. Both fields are mandatory.

4) Click **Datasheets**.
   The application opens with the selected database.

**To create a new database:**

1) Under **Another Provue Database**, click **Create New**.
   ![Create New Provue Database](image)

2) Click **Select Folder**, browse to the folder where you want to store the database and click **Select Folder**.

3) Enter the database name, enter and confirm a password for the default user [pja] and click **Create**.

4) The database you created is selected in the top pane of the initial window.

5) Enter the password you just specified and click **Datasheets**.

6) Enter the full path to the database and then click **Create**.
   The application verifies the connection and adds the database to the list of authorised databases.

**To load an external database**

1) Under **Another Provue Database**, click **Load From Folder**.

2) Browse to where the database is stored select the database file (.db) and click **Select Folder**.
   The application verifies the connection and adds the database to the list of authorised databases.

**Quitting ProvueDB.Net**

When you have finished your ProvueDB session, you can either disconnect from the database or quit the application.

**To log out of your database:**

- Click **Logout** at the top of the navigation pane.
  This disconnects you from the database and returns you to the **Authorised Databases** window
To quit ProvueDB.Net:

1) Click the Close (X) button.

This disconnects you from the database and closes the application.

**Client interface – datasheets**

Once you have logged in and connected to your database, choosing the datasheets service opens the following, or similar, client interface.

The following main features are apparent:

**Navigation pane.** The area on the left of the screen contains an expandable list of plants, projects, equipment items and datasheets. The controls at the top let you change the appearance or log out of the database.

**Main pane.** The main area of the screen contains various tabbed views. The **Status** tab is the default view when you log on.

The functions of the most commonly used tabs are described in the following sections.

**Navigation pane – controls**

The controls at the top of the navigation pane change the appearance of the tree view.

- **Logout**
  - Ends your login session.

- **By Project**
  - These controls are mutually exclusive. They lets you see the tree view with either projects (default) or plants on top.

- **By Plant**
  - Refreshes the tree view.
Status tab

The **Status** tab is the default tab that appears in the main pane of the ProvueDB.Net interface.

The **Status** tab provides a summary of your current workload, split into four sections. These show:

- **Your Actions** – any datasheets that have been assigned to you for checking and/or approving (if you have the privileges)
- **Issued in last 28 days** – datasheets issued during the period
- **Rejected in last 28 days** – datasheets that were rejected during checking/approval
- **Recent Datasheets** – the last five datasheets you have opened.

Each of these sections contain one or more active links. Clicking a link opens the relevant datasheet.

The **Quick Links** at the top show the number of signed off datasheets sets that are available for you to open (if you are a checker) and the number of checked datasheets sets that are available for you to open (if you are an approver). Clicking the link opens a filtered view of the navigation pane showing a list of the signed off or checked sets.

You can also get the same filtered views using the **Status filter** on the **Find** tab. You can clear the filter from the **Find** tab.
Find tab

The Find tab lets you filter the equipment shown in the navigation pane.

To filter the navigation pane:
1) On the Filter tab, enter one or more filters, as required.
   - **Equipment name**: Enter at least two characters. Useful if all your equipment is identified by codes (e.g. Pnnn for Pumps, etc.)
   - **Search String**: Enter at least two characters. Lets you search for particular words such as a manufacturer’s name. (This search can be slow.)
   - **Equipment Type**: Select the checkboxes.
   - **Status filter**: Click the status (Created or Fetched, Signed Off, Checked, Issued) in the list.
   - **User filter**: Select the checkboxes.
2) Click **Apply Filter**.
   The legend **Filter On** in red appears at the top of the navigation pane.

To clear the filter:
1) Click the red **Filter On** legend at the top of the navigation pane (or click the Find tab).
2) Scroll down the **Find** tab (if needed) and click **Clear Filter**.

The navigation pane shows the full data structure.

**Tools tab**

The **Tools** tab provides the following features:

- **Equipment Overview**: Opens the equipment overview dialog in a separate window.
- **Equipment Lists**: Open the Equipment Lists service in a separate window.
- **Tree Configuration**: Click option to change the appearance of equipment items in the navigation pane. The default view is to show titles only.

**Datasheet tab**

The **Datasheet** tab displays a datasheet when it is opened from the navigation pane. The tab contains a non-scrollable section at the top containing various commands and showing the workflow status of the set of datasheets, and a scrollable section containing the datasheet form.

The following commands appear in the non-scrollable section of the tab:
Prints the datasheet to PDF.

Saves the datasheet.

Client interface – equipment lists

When you have logged in and connected to your database, if you choose Equipment Lists, you see the following, or similar, client interface.

You also see this interface if you choose Equipment Lists from the Tools tab of the Datasheets interface.

The following main features are apparent:

**Specification pane.** The area on the left of the screen is a form for creating and maintaining equipment list specification files. The form is divided into four sections:

- Specification – lets you create, rename, copy or delete specifications.
- Equipment Type / Datasheets – lets you select individual datasheets to open.
- Selected fields – the fields you select on the datasheet are added to this table.
- Selected Project/Plants – lets you apply the specification to one or more plants/projects.

The Show Results button applies the completed specification, opening a spreadsheet view of the data matching its various criteria.

**Datasheet pane.** The area on the right shows a datasheet when it is selected from the specification pane.
User assistance

ProvueDB.Net has the following forms of user assistance:

- Online help
- Online documentation
- PEL Support Services

Online help

ProvueDB.Net has an integrated online help system, which provides clear reference information and step-by-step instructions for tasks. This is an online help version of this guide.

To open the help system:

  The help opens in a separate window.

Online documentation

Documentation is provided for PEL products on the website. The documents are provided as PDF files for you to download and print. These include:

- 60 second guides
- Online user guides

PEL Support Services

This program is developed, maintained and supported by PEL Support Services, ABB. We run a Hotline telephone and email service to answer any queries about ProvueDB.Net.

Please let us have any suggestions on how you feel we could improve about ProvueDB.Net. You can contact us by any of the following routes:

By Telephone: +44 (0)1925 74 1126
By Fax: +44 (0)1925 74 1265
By email: pel.support@gb.abb.com
By Post: PEL Support Services
          ABB Limited.
          Daresbury Park
          Daresbury
          Warrington
          Cheshire WA4 4BT
          United Kingdom.
Chapter 3 – ProvueDB.Net Quick Tour

This section provides tutorials to get you started with the two main parts of the application – datasheets and equipment lists. These tutorials are also available separately in print form (or as a PDF file) entitled 60 Second Guide.

Part 1 – Datasheets

This short self-paced tutorial will show you how easy it is to use ProvueDB.Net Desktop Edition and how quickly you can create professional looking datasheets.

In a short time you will have learned how to use ProvueDB.Net; you will have produced and printed out a design basis sheet, a process sheet, and a sketch for specifying a pump.

Starting ProvueDB.Net

1) Click Start > All Programs > PEL > ProvueDB > ProvueDB.Net Desktop Edition.

The first thing we need to do is select or create a database to store the datasheets. We will create a database called ‘TutorialDB’.

2) Under Another Provue Database, click Create New. Click Select Folder, browse to the folder where you want to store the database and click Select Folder. Enter the database name, TutorialDB, enter and confirm a password for the default user [pja] and click Create. The database you created is selected in the top pane. Enter the password you just specified and click Datasheets.

We are now in ProvueDB.Net. The left pane will provide a tree-view of the database, showing the names of the projects, plants, equipment, and datasheets in the same way as Microsoft Explorer shows folders on your PC. The right pane has a series of tabs, starting with a status view and including the datasheets as they are opened.

Before we can add any equipment and datasheets, we need to create a project and plant to contain them. We need to activate the administrator facilities to do this.

3) Click the Admin tab and click Grant PJA. Right-click the top node in the tree view and click New Plant. Enter the name Plant 1 and click OK. Right-click the Plant 1 node and click New Project. Enter the name Project 1 and click OK. In the Admin tab click Disable PJA and click the Status tab.

The next thing we want to do is to add a new pump called P01.
4) Expand the **PLANT 1** and **PROJECT 1** nodes. Right-click **PROJECT 1**, in the context menu point at New Datasheet and in the list of equipment types click **PUMP**. In the dialog, type **P01** and click **OK**.

Notice that **PUMP** appears in the tree view below **PROJECT 1** and **Datasheets** with your new pump below that.

Notice also that the design basis sheet opens automatically in the right pane. Let’s add some design basis text. You can either type some example text yourself, or if you have the PEL software on your computer, you can upload some sample text from the folder where PEL is installed (typically c:\Program Files).

5) To type the text yourself, click in the large text box and start typing. When you have entered some sample text, click the **Save** button at the top of the Datasheet tab.

6) Alternatively, to upload the sample text, click the **Word** button. Click **Choose File** and navigate to the install folder and the file PEL\Examples\ProvueDB\Design Basis.doc. Select the file and click **Open**. Back in the dialog, click **Submit**. The text appears in the datasheet, which is saved automatically.

Notice that **Design Basis** appears in the tree view under your pump marked by a green arrow icon telling you this datasheet is still open in the right pane.

Now let’s add some process data and (a) see how in-line units’ conversion works, (b) view the standard design procedures to help fill in the datasheet, and (c) calculate some physical properties.

7) Right-click your pump in the tree view, in the context menu point at **New datasheet** and in the list of available datasheets for a pump click **Process**.

The Process datasheet opens in the right pane.

8) Enter a value of **60 F** in the **Temperature** box for Case 1 (line 8). When you press **Enter** or click another box, the value is converted to 15.556°C – the units shown on the datasheet.

9) Enter the following values for Case 1:

<table>
<thead>
<tr>
<th></th>
<th><strong>VAPOUR PRESSURE AT OP. TEMP</strong></th>
<th>0.25 psia (converts to 0.0172369 bara)</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td><strong>VISCIOSITY AT OPERATING TEMP</strong></td>
<td>0.9982</td>
</tr>
<tr>
<td>25</td>
<td><strong>DENSITY AT OPERATING TEMP</strong></td>
<td>999.5</td>
</tr>
<tr>
<td>26</td>
<td><strong>MIN PRESSURE IN VESSEL</strong></td>
<td>1.25</td>
</tr>
<tr>
<td>28</td>
<td><strong>MAX PRESSURE IN VESSEL</strong></td>
<td>2.5</td>
</tr>
</tbody>
</table>

10) Right-click in line 34 for Case 1 (Pressure at Pump Flange) and click **Suction + Delivery Case 1**. The following values are calculated:

<table>
<thead>
<tr>
<th></th>
<th><strong>PRESSURE AT PUMP FLANGE</strong></th>
<th>1.25</th>
</tr>
</thead>
<tbody>
<tr>
<td>34</td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td><strong>PRESSURE AT PUMP FLANGE</strong></td>
<td>12.7485</td>
</tr>
<tr>
<td>36</td>
<td><strong>N.P.S.H. (AVAILABLE)</strong></td>
<td>12.5727</td>
</tr>
<tr>
<td>44</td>
<td><strong>PRESSURE AT PUMP FLANGE</strong></td>
<td>2.5</td>
</tr>
<tr>
<td>45</td>
<td><strong>PRESSURE AT PUMP FLANGE</strong></td>
<td>25.4969</td>
</tr>
<tr>
<td>46</td>
<td><strong>DIFFERENTIAL HEAD ACROSS PUMP</strong></td>
<td>12.7485</td>
</tr>
</tbody>
</table>

11) Click the **Save** button to save the data to the database. (Notice that the data goes **blue** to show it has been saved.)

Notice that **Process** also appears in the tree view under your pump marked by a green arrow icon telling you this datasheet is still open in the right pane.
Finally, let’s quickly add a sketch datasheet. You can draw the sketch using any graphics tool on your computer. We’ll choose Microsoft Visio. For this you’ll need to save both the Visio file and an exported image file.

12) Start Microsoft Visio and select an appropriate Engineering template, such as Process Flow Diagram. Drag some suitable shapes on to the drawing to make a sketch before saving the file as Drawing.vsd. Then use the Save As command to save the drawing in an image format, such as Portable Network Graphics format (.png).

Now let’s create the sketch datasheet and upload the files to it.

13) Right-click your pump in the tree view, in the context menu point at New datasheet and click Sketch. When the Sketch datasheet appears, click in the box where the sketch is to appear. The Upload new image/data file dialog opens.

14) Click Browse to navigate to the image file (.png) and then the data file (.vsd). Then click Upload file. The image appears in the datasheet, which is saved automatically.

Notice again that Sketch appears under your pump marked with a green arrow icon.

To complete the exercise let’s print out the datasheets to your default printer.

15) Right-click your pump in the tree view and click Print all to PDF. The system will create a PDF file containing all three datasheets. This opens in a separate browser window. You can save this locally and print the pages on your local printer.

And that’s it. Now you’ve learned the basics it’s time to read the ProvueDB.Net User Guide. This will tell you more about all of the really useful features and options in the program.

Part 2 – Equipment Lists

This short self-paced tutorial will show you how to use ProvueDB.Net Desktop Edition to create and maintain equipment lists.

Starting ProvueDB.Net

1) Click Start > All Programs > PEL > ProvueDB > ProvueDB.Net Desktop Edition.
The first thing we need to do is select a database to store the equipment lists. We will use the database we created in Part 1 of the tutorial.

2) In the top pane, select TutorialDB, enter your User Name and Password and click Equipment Lists.

We will now create a specification file. This file remembers all data items we want to retrieve from the database and how we want it listed – the column headers, units of dimension, etc. In fact everything except where the data is to be retrieved from.

3) Select <Create new> in the Open list and then enter a name for the specification file (such as pumps followed by your user id) and click OK.

We will restrict this equipment list to pumps.

4) Scroll down the list of equipment types and click PUMP.

The pane to the right lists the valid datasheets for a pump. We are going to select fields from the Process and Mechanical datasheets. The fields go blue when they have been selected.

5) In the list of datasheets, click Process to show the Pump Process datasheet in the far right pane and click the Flowrate field on line 18 in column 1 and the Differential Head Across The Pump on line 46, column 1.

6) In the list of datasheets, click Mechanical and click the fields Design Pressure and Design Temperature on line 12.

The last thing we want to do is to add meaningful names for the columns.

7) Scroll down to the Selected Fields list and add column names as follows:

<table>
<thead>
<tr>
<th>Equipment</th>
<th>DataSheet</th>
<th>Field</th>
<th>Units</th>
<th>Column Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PUMP</td>
<td>Process</td>
<td>VOLUMEFLOW1</td>
<td>m³/h</td>
<td>Flowrate</td>
</tr>
<tr>
<td>PUMP</td>
<td>Process</td>
<td>HEADLOSSACROSSPUMP1</td>
<td>m</td>
<td>Diff Head</td>
</tr>
<tr>
<td>PUMP</td>
<td>Mechanical</td>
<td>DESIGNPRESS</td>
<td>barg</td>
<td>Design Pressure</td>
</tr>
<tr>
<td>PUMP</td>
<td>Mechanical</td>
<td>DESSTEMP</td>
<td>C</td>
<td>Design Temp</td>
</tr>
</tbody>
</table>

That completes the specification so we now need to select the project(s) and plant(s) to supply the data. We don't have many options with this database but with a working database there could be many to choose from.

8) Scroll down to the Selected Projects/Plants list and select the PROJECT 1 / PLANT 2 checkbox and click Show Results. 

ProvueDB retrieves the selected data fields from all the pumps in PROJECT1 / PLANT 2 and shows them in a spreadsheet.

We will now use Equipment Lists to add some more pumps to the database.

9) Below the last row of the table, enter a new pump, P110 (or the next available number). Enter the data as shown below and then click Save Changes to add the data to the database.

<table>
<thead>
<tr>
<th>Pump</th>
<th>Title</th>
<th>Flowrate</th>
<th>Diff Head</th>
<th>Design Pressure</th>
<th>Design Temp</th>
</tr>
</thead>
<tbody>
<tr>
<td>P110</td>
<td>STAGE 1 KEROSENE RECIRCULATION PUMP</td>
<td>5.0</td>
<td>10.0</td>
<td>3.0</td>
<td>20.0</td>
</tr>
</tbody>
</table>

The values are initially in red as you add them, but change to blue when you click Save Changes.
10) Add four more pumps (with the next sequentially available numbers).

<table>
<thead>
<tr>
<th>Pump</th>
<th>Title</th>
<th>Flowrate</th>
<th>Diff Head</th>
<th>Design Pressure</th>
<th>Design Temp</th>
</tr>
</thead>
<tbody>
<tr>
<td>P112</td>
<td>STAGE 1 HEATING LOOP PUMP</td>
<td>5.5</td>
<td>7.0</td>
<td>2.5</td>
<td>22.0</td>
</tr>
<tr>
<td>P113</td>
<td>STAGE 2 REACTOR PUMP</td>
<td>3.2</td>
<td>12.0</td>
<td>2.0</td>
<td>37.0</td>
</tr>
<tr>
<td>P114</td>
<td>STAGE 2 DISTILLATE PUMP</td>
<td>2.0</td>
<td>13.0</td>
<td>2.0</td>
<td>37.0</td>
</tr>
<tr>
<td>P115</td>
<td>STAGE 2 EXTRACTION VESSEL PUMP</td>
<td>4.2</td>
<td>9.0</td>
<td>2.5</td>
<td>15.0</td>
</tr>
</tbody>
</table>

11) Click **Back to Specification** to close the spreadsheet and return to the Equipment List window.

12) Click the **Logout** button, select the same database, enter your password again and click **Datasheets** to open the Datasheets view.

13) Expand the tree-view to check that the pumps have been added successfully. Expand any of the pumps to see that a process and a mechanical datasheet have been added.

14) Click the **Tools** tab and click **Equipment Lists** to open in a new browser window.

15) In the Open list click your Pumps specification and click **Load**. Then click **Show Results** to get back to the spreadsheet view.

Now let’s export the data as a CSV list and open in Microsoft Excel.

16) In the top left of the spreadsheet, click **Download table as CSV file**. Select all the text and then copy and paste into a text editor such as Notepad. Click **Save** and browse as required to save the file to your desktop as **MyPumps.csv**. Then click **Open** to open in Microsoft Excel.
Chapter 4 – Understanding datasheets

The process datasheets generated by ProvueDB.Net have evolved from a series of standardised procedures originally developed by the ICI Engineering Department. They provided a method of documenting process engineering projects from defining the initial requirements through to plant operation.

This chapter describes and shows typical examples of the most common types of datasheets.

Example common datasheets

Each item of equipment or process defined in ProvueDB.Net will have a number of datasheets referred together as a set. The workflow commands of fetching, signing off, checking and approving always act on the whole set, not just on an individual sheet.

For each equipment type or process, the datasheet set most commonly includes:

- **Design Basis** sheet
- **Process** datasheet
- **Mechanical** datasheet
- **Miscellaneous** datasheet
- **Sketch** datasheet

The following sections show typical examples of these common data sheets.
**Design basis sheet**

Typically the first sheet in the set, the Design Basis sheet provides a brief description of the function of the item of equipment, the reasoning behind its selection, the duty, instrumentation, safety considerations etc. so that the design philosophy is clear both to the project team and eventually to the commissioning and operating personnel.

It is the only sheet in the set with full identification details of the item as well as the revision table.

These pumps are positive displacement metering pumps which directly inject DEG through one of the two injection nozzles before the Buffer vessel. The flow of DEG is varied to match the plant conditions and throughput. DEG is also added with additives 'A', 'B' and 'D'. The direct injection pumps will normally be used to make up the total DEG addition rate to the polymer stream and give some fine tuning. A desired level is required in the final polymer, which is defined in the product specification.

These pumps are inverter driven metering pumps because the flow rate required is small, relatively high delivery pressures and constant accurate flow rates are required. The flowrate is automatically controlled by the inverter speed. The stroke length can also be varied for coarser adjustment by a manual handwheel.

These pumps should be double diaphragm heads with hydraulically operated diaphragms. (This will protect against diaphragm ruptures) and leak detection. An external relief device on the pump discharge will protect against over pressure, relieving into the pump suction.

1. The pump head, body and valves will be stainless steel and the diaphragm PTFE.
2. The pump rate is normally monitored by a flowmeter and pressure gauge, should the flowmeter fail, then the pump delivery can be set by the stroke length and speed until the meter can be replaced.
3. The pumps should be capable of achieving an accuracy of 1% to the desired flow rate. The pump should not run at speeds in excess of 80 strokes per minute.

The installed power for each pump is 0.42 kW.
### Process data

The Process Data sheet typically contains three operating cases containing various fluid flow calculations so that the intended items can be correctly sized. The format of the sheet is specific to the equipment or process type. The example shown below gives process data for a pump.

<table>
<thead>
<tr>
<th>CASE NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PROCESS DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>DESCRIP.</td>
</tr>
<tr>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FLUID NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TEMPERATURE</th>
</tr>
</thead>
<tbody>
<tr>
<td>60</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MIN/MAX TEMPERATURE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SOLID CONTENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>kg/m³</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SEDIMENT PARTICLE SIZE RANGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>µm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SEDIMENT PARTICLE DENSITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>kg/m³</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>GAS CONTENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>perc</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FLOW CHARACTERISTICS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AREA CLASSIFICATION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FLOW FLUIDS AND PHYSICAL PROPERTIES</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FLOWRATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.56476</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SPECIFIC HEAT</th>
</tr>
</thead>
<tbody>
<tr>
<td>4187.88</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ATMOSPHERIC PT</th>
</tr>
</thead>
<tbody>
<tr>
<td>212</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LHV</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0173369</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>VIISCOSITY AT OPERATING TEMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>999.5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DENSITY AT OPERATING TEMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>kg/m³</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MIN/MAX PRESSURE IN VESSEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.25</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DUAL HEAD ABOVE PUMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.25</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PRESSURE DROP SYSTEM</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MAX PRESSURE IN VESSEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MANIFOLD</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PUMP CURVE REQUIRED</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SUGGESTED RELAY VALVE SETTINGS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>INDICATION</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ADDITIONAL COMMENTS, INCLUDE ANY SPECIAL REQUIREMENTS FOR COMMISSIONING OR FOR CLEANING</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>STATE DUMP-TANK RESIDENCE TIME</th>
</tr>
</thead>
<tbody>
<tr>
<td>IF &gt; 100 SECONDS</td>
</tr>
</tbody>
</table>

| THE INFORMATION ON THIS DATA SHEET IS CONFIDENTIAL TO ABB |
| AND SHALL NOT BE DISCLOSED TO A THIRD PARTY WITHOUT PRIOR WRITTEN PERMISSION |
# Mechanical data

Though not included for all equipment types and processes, the Mechanical Data sheet typically includes physical data, such as sizing and material of construction. For a purchased item it may also include the manufacturer name and part number, dimensions and maintenance information.

<table>
<thead>
<tr>
<th>PROCESS DATA SHEET</th>
<th>PROJECT No.</th>
<th>SHT 4 OF 5</th>
<th>EQUIP No.</th>
<th>F202</th>
</tr>
</thead>
<tbody>
<tr>
<td>PUMP (MECHANICAL DATA)</td>
<td>EQUIP.TITLE</td>
<td>PROJ.TITLE</td>
<td>EXAMPLE DATASHEETS</td>
<td></td>
</tr>
<tr>
<td>MECHANICAL DATA</td>
<td>REV.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>DUVOLIATED DESIGN PRESSURE</td>
<td>340</td>
<td>PUMP</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>DUVOLIATED DESIGN TEMPERATURE</td>
<td>340</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>DISSOLUTED CONSTRUCTION MATERIALS</td>
<td>Stainless steel</td>
<td>Alum steel</td>
<td>Casing</td>
</tr>
<tr>
<td>4</td>
<td>RUNNING TIME</td>
<td>340</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>CONTROL BY</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>SIGNIFICANT RUNNING AT NO FLOW</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>PUMP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>CYL STROKE TIME-12X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>MACHINES DATA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>MANUFACTURER</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>TYPE OF SEAL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>DESIGN PRESSURE</td>
<td>kgf</td>
<td>DESIGN TEMPERATURE</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>MATERIAL OF CONST.</td>
<td>Casing</td>
<td>Shaft</td>
<td>Impeller</td>
</tr>
<tr>
<td>14</td>
<td>PUMP IN PARALLEL</td>
<td>NUMBER IN PARALLEL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>CV LOSS AREA</td>
<td>m²</td>
<td>CV BYPASS FLOW</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>SHRT OFF HEAD</td>
<td>m</td>
<td>N.P.C. REQUIRED</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>IMP/LEL DMN Fitted</td>
<td>m</td>
<td>SPEED</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>IMP/LEL DMN MAX</td>
<td>m</td>
<td>IMP/LEL DMN MIN</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>NOISE RATINGS</td>
<td>m/s</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>DERIVED DATA</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>ELECTRICITY</td>
<td>w/kg</td>
<td>PHASE</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>WATER</td>
<td>kg</td>
<td>m³</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>STEAM</td>
<td>kg</td>
<td>kg/h</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>PUMP CURVE (SUPpl)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>ADDITIONAL COMMENTS</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

THE INFORMATION ON THIS DATA SHEET IS CONFIDENTIAL TO ABB AND SHALL NOT BE DISCLOSED TO A THIRD PARTY WITHOUT PRIOR WRITTEN PERMISSION.
**Miscellaneous sheet**

This free-format sheet lets you add any information not covered on the other sheets. It contains a single large description field that can be either entered direct (text mode) or uploaded from a Microsoft Office Word document.

```
<table>
<thead>
<tr>
<th>ABB</th>
<th>PROCESS DATA SHEET</th>
<th>EQUIP No.</th>
<th>SHT. 2 OF 3</th>
<th>PROJECT No.</th>
<th>PROJ. TITLE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MISCELLANEOUS SHEET</td>
<td>E101</td>
<td>A1</td>
<td>EXAMPLE PROJECT</td>
<td>EXAMPLE DATASHEETS</td>
</tr>
<tr>
<td></td>
<td>EQUIP. TITLE</td>
<td></td>
<td></td>
<td>Shell and Tube Heat Exchanger</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PROJ. TITLE</td>
<td></td>
<td></td>
<td>EXAMPLE PROJECTIONS</td>
<td></td>
</tr>
</tbody>
</table>

Add any extra information not covered on the other sheets.

THE INFORMATION ON THIS DATA SHEET IS CONFIDENTIAL TO ABB AND SHALL NOT BE DISCLOSED TO A THIRD PARTY WITHOUT PRIOR WRITTEN PERMISSION.
Sketch sheet

This datasheet lets you add an image or drawing of the equipment. Typically, this would be a general arrangement drawing showing the item and any connected pipework. It could be an engineering drawing of the item created in a CAD drawing tool or a process flow diagram produced in Microsoft Office Visio. Both the application file and an exported image file need to be uploaded.
Chapter 5 – Workflow and approval cycle

This chapter describes the workflow in developing datasheets, explaining how ownership of datasheets works and how groups can be used to restrict facilities to particular user roles.

Datasheet workflow

The workflow in creating and maintaining datasheets for an item of plant equipment involves four stages:

- **Fetched** – the item has been created or retrieved (fetched) for modifying
- **Signed off** – the item has been signed-off by the user
- **Checked** – the item has been checked by a different user (checker)
- **Issued** – the item has been approved for issue by an approver

At each stage in the workflow, a workflow command effects all the datasheets for an individual piece of equipment. The current status appears on the non-scrolling part of the **Datasheet** tab.

The status also appears in the navigation pane against the equipment instance. This shows more clearly that the workflow status refers to the whole set of datasheets.
Working in the Fetched stage

When you first create a set of datasheets, the status is **Fetched**. A single command is available to **Signoff** the set when you have added all the sheets.

If you fetch an existing set for editing, there are two commands, **Signoff** and **Reject**. The **Reject** command at this stage returns the set of datasheets to the last issued state. Any changes you may have made to the datasheets are lost.

Working in the Signed off stage

Once the originating author has signed off the datasheet set, the status changes to **Signed Off**. Editing the datasheets is now restricted to users with the ability to check datasheets in the group to which the Equipment belongs.

When a checker edits a datasheet in the set, the set becomes locked to that user. Ownership, however, remains with the author who signed off the set.

When you open a datasheet for checking, there are two commands, **Check** and **Reject**. The **Check** command says you have checked the original datasheets (or the changes if this is a reissue) and are happy with them.

If you find any errors in the set of datasheets, you can **Reject** the set. This returns the set to the **Fetched** state with a reason entered for the rejection. Ownership reverts to the author who signed off the datasheet set. The author can make the necessary changes before signing off the set a second time.

Working in the Checked stage

Once the checker has ‘checked’ the datasheet set, the status changes to **Checked** and ownership moves to the checker. Editing the datasheets is now restricted to users with the ability to approve datasheets in the group to which the Equipment now belongs.

When an approver edits a datasheet in the set, the set is locked to that user, with ownership shown as the checker.

Again there are two available commands, **Approve** and **Reject**.

The **Approve** command says the datasheets are now approved for issue. In the issued state, the datasheets are set to read only, with no ownership. The next revision number (as determined by the revision sequence) appears in the issue record.
If you reject the datasheets as an approver, the status again reverts to **Fetched**, with a reason entered for the rejection. Ownership reverts to the user who signed off the set to make corrections.

**Equipment ownership**

When Equipment is created it is “Owned” by the user who created it.

Ownership is transferred when the Equipment is Checked, Transferred or Rejected. If the Equipment is “Rejected” at any point then Ownership returns to the creating user. When an Equipment item is “Approved” then it has no owner until it is then “Fetched”, whereby the fetcher becomes the new Owner.

**Using groups**

Groups in ProvueDB.Net let you maintain access control by separating the different functions of creating, checking and approving equipment in the approval cycle. Groups are not explicitly created, but are created indirectly when adding or editing users. Each user is assigned to a particular group using a single letter in the range A-Z. A user can only belong to one group.

The user setup process also assigns groups for checking and approving. By creating your users in different groups by function (that is, Equipment Author, Checker and Approver) you can ensure that originators cannot check and approve their own work.

**Groups example**

<table>
<thead>
<tr>
<th>User</th>
<th>Group</th>
<th>Check Group</th>
<th>Approve Group</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Archer</td>
<td>A (Authors)</td>
<td></td>
<td></td>
<td>Fetch and sign off datasheets</td>
</tr>
<tr>
<td>B. Brown</td>
<td></td>
<td>A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C. Cook</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D. Dunn</td>
<td>B (Checkers)</td>
<td></td>
<td>A</td>
<td>Check datasheets signed off by users in Group A.</td>
</tr>
<tr>
<td>E. Evans</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F. Fraser</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G. Gill</td>
<td>C (Approvers)</td>
<td></td>
<td>B</td>
<td>Approve datasheets checked by users in Group B.</td>
</tr>
<tr>
<td>H. Hunt</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I. Ince</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can also use groups to distinguish other categories of user, such as contractors, suppliers and customers.

The group assignments determine who can edit the datasheets at each stage. Any user can view and print the datasheets (unless they are hidden from that user). Until datasheets have been approved for the first time, “Preliminary” appears in red across the top of the sheet.

**The approval process**

When Equipment is created it is owned by the Author and the Group to which the Author belongs. When “Signed Off” by the Author, it can only be Checked by a Checker who is setup to “Check” the group to which the Equipment belongs. When Checked by a Checker, ownership now moves to the Checker and the Group to which the Checker belongs. Now, the equipment can only be approved by an Approver who is setup to “Approve” the new “Checkers” group. In this way, each person in the approval process is checking the last person’s work.
User A Creates and Saves New Equipment & becomes the Owner

User A, Author & Owner

Reject the Previously Issued Equipment

User B, New Owner

Edit Rule: When Fetched, only the Owner or the PJA can Edit the Equipment

Transformed and now owned by User B

Signoff, Reject Or Transfer

User B, New Owner

Only the Owner can Sign Off. Only the Owner or PJA can Reject Fetched and previously Issued Equipment. The Owner or the PJA can Transfer to another user who becomes the new owner

Signed Off

Edit Rule: When Signed Off, only Checkers or the PJA can Edit the Equipment

Signed Off

Check or Reject

Yes, Checked

Equipment now owned by Checker

No, Reject

Only Checkers or the PJA can Check

No, Reject, Ownership returns to Author User A

Checked

Edit Rule: When Checked, only Approvers or the PJA can Edit the Equipment

Approve or Reject

Yes, Approved

Edit Rule: When Issued, Equipment is read-only

Issued

Yes, Approved

Only an Approver or the PJA can Approve

User C, New Owner

Fetch to next Rev?

Fetch and now owned by User C
Chapter 6 – Managing datasheets

The task of creating and maintaining all the datasheets for a project or plant involves first adding equipment items to your plant or project and then developing a set of datasheets for each item. This chapter shows you how to manage equipment items and datasheets.

Managing equipment items

The navigation pane allows you to manage the individual items of equipment for a particular plant/project. All the commands are accessed from the (right-click) context menu.

Adding new equipment

Equipment items are added in the navigation pane at two levels – an equipment type node that defines what the item is (pump, valve, etc.) and an equipment instance node that specifies a unique identifier. When you add the first item of a particular type you create both levels. Once you have one item of that type you can add subsequent items from the existing equipment type node.

Note In the ProvueDB.Net navigation pane you can show either projects or plants as the top level. For simplicity the following instructions are in the default arrangement (project at the top).

To add new equipment (first use):

1) In the navigation pane, right click the plant node, click New Datasheet, and then click the type you want in the equipment list.

2) In the dialog box, enter the Name for the item, and then click OK.

A new equipment node (and a new item under it) is added under the plant node in the navigation pane. The initial datasheet opens ready for you to complete.
To add new equipment (subsequent use):

1) In the navigation pane, right click the equipment type node and click **New**.

2) In the dialog box, enter the **Name** for the item, and then click **OK**.
   A new item is added under the equipment type node in the navigation pane. The initial datasheet opens ready for you to complete.

Renaming equipment

**Note**  This command is only available to the originating author when the equipment item and its datasheets are being created initially and while the item remains in the Fetched state.

**Note**  Once the set of datasheets has been approved and issued, only the System administrator can rename the equipment item.

To rename an equipment item:

1) In the navigation pane, right click the equipment instance node and click **Rename**.
2) In the dialog box, change the **Name** as required, and then click **OK**.

Replicating equipment

The copy and paste commands let you replicate an item of equipment.

To copy an equipment item:

- In the navigation pane, right click the equipment instance node and click **Copy**.
To paste the equipment item:

1) In the navigation pane, right click either the plant node or the equipment type node and click Paste.

2) In the dialog box, enter the Name for the item. If you do not want the copied item to share the same revision status as the original clear the checkbox.

3) Click OK.

A new item is added under the equipment type node in the navigation pane.

Deleting equipment

Note This command is only available to the originating author when the equipment item and its datasheets are being created initially and while the item remains in the Fetched state.

Note Once the set of datasheets has been approved and issued, only the System administrator can delete the equipment item.

To delete an equipment item:

1) In the navigation pane, right click the equipment instance node and click Delete.

A prompt asks you if you want to delete the item.

2) Click OK.

The equipment instance (and any datasheets under it) is removed from the navigation pane.

Creating datasheets

The initial datasheet for an equipment item is opened automatically when you add the equipment item. Other datasheets may be added, copied, amended or deleted as required.

Adding a datasheet

To add a datasheet:

1) In the navigation pane, right click the equipment instance node, click New, and then click the datasheet you want in the list.

The datasheet opens as a tab in the main pane.

2) Complete the various fields on the form as required.

3) When you have completed the form, click the Save button at the top of the Datasheet tab.

Opening an existing datasheet

To open a datasheet:

1) In the navigation pane, expand the equipment instance node to show the current datasheets.

2) Do one of:
Right-click the datasheet you want in the list and click **Open**.

Double-click the datasheet you want in the list.

The datasheet opens as a tab in the main pane.

**Copying a datasheet**

The copy and paste commands let you copy a datasheet.

**To copy a datasheet:**

1) In the navigation pane, right click the datasheet you want in the list and click **Copy**.

A prompt tells you the item has been copied.

2) Click **OK**.

3) In the navigation pane, right click equipment instance node (above the copied datasheet) and click **Paste**.

The datasheet is added under the equipment instance node in the navigation pane.

**Note** You can make multiple copies of a datasheet.

**Closing a datasheet**

**To close an open datasheet:**

- Click the Close (X) button at the top right of the **Datasheet** tab.

  If any data is unsaved, you are warned that this data will be lost.

If you want to save the data, click **Cancel** and click the **Save** button before trying again.

**Deleting a datasheet**

**Note** This command is only available to the originating author when the datasheets are being created initially and while the datasheet set remains in the Fetched state.

**Note** Once the set of datasheets has been approved and issued, only the System administrator can delete a datasheet.

**To delete a datasheet:**

1) In the navigation pane, right click the datasheet you want in the list and click **Delete**.

A prompt asks you if you want to delete the item.

2) Click **OK**.

The datasheet is removed from the navigation pane.
Managing other document types

The facility for adding other types of document is much like adding items of equipment. This lets you create calculation sheets and reference sheets that are not confined to particular equipment types. The calculation and reference datasheets can then be linked to specific equipment datasheets. See Linking datasheets” on page 43.

Adding a calculation or reference sheet

Calculation or reference sheets are added in the navigation pane at two levels – a document type node (i.e Calculation or Reference) and a document instance node that specifies a unique identifier. When you add the first item of a particular type you create both levels. Once you have one item of that type you can add subsequent items from the existing document type node.

Note In the ProvueDB.Net navigation pane you can show either projects or plants as the top level. For simplicity the following instructions are in the default arrangement (project at the top).

To add new document (first use):

1) In the navigation pane, right click the plant node, point to New Calculations (or New References), and then click the type, Calculation (or Reference).

2) In the dialog box, enter the Name for the type of document, and then click OK.

A Calculation or Reference node (and a new item under it) is added under the plant node in the navigation pane. The Calculation or Reference frontsheet opens ready for you to complete.

To add new document (subsequent use):

1) In the navigation pane, right click the Calculation or Reference node and click New.

2) In the dialog box, enter the Name for the document, and then click OK.
A new item is added under the Calculation (or Reference) node in the navigation pane. The Calculation (or Reference) frontsheet opens ready for you to complete.

**Renaming, Replicating or Deleting a document**

These commands on the right-click menu work exactly the same as their equivalents for equipment items.

**Viewing status overview**

This feature lets you see an overview of the status of each item for a particular plant or project.

**Note** In the ProvueDB.Net navigation pane you can show either projects or plants as the top level. For simplicity the following instructions are in the default arrangement (project at the top).

**To view the status overview:**

1) Do one of:

   • In the navigation pane, right click the plant node and click **Overview**.
   • In the **Tools** tab, click **Overview**.

   The equipment overview dialog opens in a separate window.

2) If required, select a particular status in the **Status** list.

   A filtered view appears.

   **Note** You can print this view, if required.

3) Click the close button (in the top right corner) to close the window.
Chapter 7 – Working with datasheets

This chapter describes the workflow commands for developing datasheets, shows you how to enter data, upload Microsoft Office Word documents and graphics files to individual datasheets and describes how to print datasheets.

Datasheet workflow commands

The workflow in developing datasheets involves a four-stage approval cycle.

_Fetched > Signed Off > Checked > Issued_

Changes in status of the datasheet set is shown on the non-scrolling part of the Datasheet tab.

The status is also shown in the navigation pane against each equipment instance.

Fetching an item for editing

This is used to retrieve an issued item for editing and reissue.

To fetch an item of equipment:

1) Do one of:
   • In the **Datasheet** tab, click the **Fetch** button.
   • In the navigation pane, right click equipment instance node, click **Status** and then click **Fetch**.

   A prompt asks you to confirm this.

2) Click **Yes**.

   If the equipment revision sequence has been set to allow secondary numbers in the first revision (e.g. A1 to A9, then B, C, etc.) a pop-up window prompts you to select either the next secondary revision number or the next full issue number.

   Once you select a full issue number the prompt no longer appears.

3) Select the revision number and click **OK**.

   The status changes to **Fetched** and is now ready for editing.
Transferring an item

This option lets you transfer the ownership of a fetched item of equipment to another user.

**Note** You can only transfer an item if you already have ownership.

**To fetch an item of equipment:**

1) In the navigation pane, right click equipment instance node, click **Status** and then click **Transfer**.
   
   A pop-up dialog lets you select which user to transfer the equipment item to.

2) Select the user in the list and click **OK**.
   
   The status remains as **Fetched** but the navigation pane now shows the items as “Fetched by” the new owner.

Signing off an item of equipment

**To sign off an item of equipment:**

1) If you have finished creating or modifying the datasheet and are ready to send the data for checking, do one of:
   
   - In the **Datasheet** tab, click the **Signoff** button.
   - In the navigation pane, right click equipment instance node, click **Status** and then click **Sign Off**.
   
   A prompt asks you to confirm this.

2) Click **Yes**.
   
   A pop-up dialog lets you send a message to one or more checkers.

3) If required, select the checkers you want to contact and click **Send**. Otherwise, click **No emails**.
   
   If you selected emails, a prompt asks you to confirm this.

4) Click **OK**.
   
   The status changes to **Signed Off** and is now ready for checking.

Checking an item of equipment

This command is only available if the item of equipment has been signed off.

**Note** You can only check items if your user profile has been set up to allow this.

**To check an item of equipment:**

1) If you have reviewed the datasheets and are ready to send the data for approval, do one of:
   
   - In the **Datasheet** tab, click the **Check** button.
   - In the navigation pane, right click equipment instance node, click **Status** and then click **Check**.
   
   A prompt asks you to confirm this.
2) Click **Yes**.

3) If required, select the approvers you want to contact and click **Send**. Otherwise, click **No emails**.
   
   If you selected emails, a prompt asks you to confirm this.

4) Click **OK**.
   
   The status changes to **Checked** and is now ready for approval.

### Approving an item of equipment for issue

This command is only available if the item of equipment has been signed off and checked.

**Note** You can only approve items if your user profile has been set up to allow this.

**To approve an item of equipment:**

1) If you have reviewed the datasheets and are ready to approve the data for issue, do one of:
   - In the **Datasheet** tab, click the **Approve** button.
   - In the navigation pane, right click equipment instance node, click **Status** and then click **Approve**.

   A prompt asks you to confirm this.

2) Click **Yes**.
   
   The status changes to **Issued**.

### Entering and editing data fields

The Process Data and Mechanical Data sheets that are used by many equipment types contain a grid of small data fields. Some of these will be text fields, but most are for entering numeric values, with or without units.

#### Entering data fields

Simple data and text fields appear with a grey background.

**To enter text or a value:**

1) Click the field.
   
   The background changes to red.

2) Enter the text or value in the field and press **Enter** (or click another field).
   
   The enter text/value appears in red.

3) Repeat for other fields as required.

4) When you have finished, click the **Save** button at the top of the **Datasheet** tab.
   
   The saved text/values change to blue.
Converting units and values

The units for any field appear on the datasheet. These are defined when the database is set up. Sometimes the source data to be entered may be in different units. For example, if a pressure is shown in bar, while the source data is in psi. Rather than have to convert the value in another application, you can enter the value with the units and ProvueDB.Net will do the conversion inline.

To convert a value inline:

- Enter the data in the format:
  
  Value <space> units
  
  and then press Enter (or click another field).

  The value is converted to the units shown on the datasheet.

Example:

For a pressure in bara, entering “0.25 psia” converts to 0.0172369.

Entering data fields involving a calculation

Data fields with a green background have calculations associated with them.

To enter the associated values for a calculation:

1) Right-click in the green data field and click the appropriate calculation on the context-menu.

   The related fields which need to be completed are highlighted by a red border.

2) Complete all the highlighted fields in turn.

3) Right-click in the green data field and click the calculation again.

4) The calculated value (or values, if more than one field is linked to the calculation) appears in red.

5) When you have finished, click the Save button at the top of the Datasheet tab.

   The saved values change to blue.

Viewing previous versions of data fields

The SQLite database used by ProvueDB.Net retains previous versions of a data field. You can view these when you update a field, if you wish.

To view previous versions of a data field:

1) In the Datasheet tab, click the Audit Trail button.

   The text in the button changes to ON.

2) In the datasheet click a field you want to change.

   A popup window appears with a table of previous values.
To hide previous versions of a data field:

- In the **Datasheet** tab, click the **Audit Trail** button.
  
The text in the button changes to **OFF**.

### Text processing in ProvueDB.Net

The Design Basis and Miscellaneous sheets that are used by many equipment types each contain a large description field that can be either entered direct (text mode) or uploaded from a Microsoft Office Word document.

#### Entering a description field in text mode

**To enter a description field in text mode:**

1. In the datasheet, click in the large description field.
   
   A formatting menu and toolbar appears above the field. The tools are equivalent to those available in Microsoft Office. Move the pointer over any tool to view its function.

2. Enter your description text as required.

3. When you have finished, click the **Save** button at the top of the **Datasheet** tab.

#### Re-pagination

If you have entered more text than can be accommodated on the printed sheet, the data is automatically moved onto a continuation sheet when you click **Save**. A second datasheet (with the same name) is added in the navigation pane.

The full text flow remains in the first datasheet for editing. The overflow text in the continuation sheet appears as read-only and cannot be edited. To see where the page break occurs, either click **Print** to view the initial page as a PDF file or open the second page.

If you subsequently edit the description so that the text can fit on a single sheet, the continuation sheet is automatically removed when you save the datasheet.

#### Uploading a description field from Word

**To upload an empty description field from a Word document:**

1. In the **Datasheet** tab, click the **Word** button.
2) In the popup dialog box, click **Browse** and navigate to your word file.

3) Double-click the file and then click **Upload Word Doc**.
   
The text appears in read-only format in the datasheet, which is saved automatically.

### Re-pagination

If the file contains more text than can be accommodated on the printed sheet, the data is automatically moved onto a continuation sheet, which is added (with the same name) in the navigation pane.

### To clear the uploaded text:

1) In the **Datasheet** tab, click the **Word** button.

2) In the popup dialog box, click **Clear Word Upload**.
   
   A prompt asks you to confirm this.

3) Click **OK**.

### Downloading the Word description file

#### To download the current uploaded text:

1) In the **Datasheet** tab, click the **Word** button.

2) In the popup dialog box, click **Download Word Doc**.

3) In the message dialog, do one of:
   
   - Click **Open** to open the Word document.
   - Click **Save** to save the file to disk.

### Adding sketches to a datasheet

The Sketch sheets that are used by many equipment types each contain a large image field for showing an illustration of the plant item. Typically this will be a simple line drawing created in a vector-based application such as Microsoft Office Visio.

You will need to upload both the application source (data) file and an exported image file in a graphics format, such as png or jpeg. The image file appears in the datasheet: the application file is retained for future editing.

### Uploading the sketch files

#### To upload the sketch files:

1) In the Sketch datasheet, click in the box where the sketch is to appear.
   
   The **Upload new image/data file** dialog opens.
2) For the image file, click **Browse** and navigate to the image file (.png or .jpeg).

3) For the data file, click **Browse** and navigate to the application source file (e.g. .vsd for Visio).

4) Click **Upload file**.

   The image appears in the datasheet, which is saved automatically.

**Downloading the current sketch files**

**To download the current sketch files:**

1) In the Sketch datasheet, click in the sketch image. The **Upload new image/data file** dialog opens.

2) Click the image file link.

3) In the message dialog, do one of:
   - Click **Open** to open the file. In the default viewer.
   - Click **Save** to save the file to disk.

4) Repeat for the data file.

**Clearing the current sketch files**

**To clear the current sketch files:**

1) In the Sketch datasheet, click in the sketch image. The **Upload new image/data file** dialog opens.

2) Click **Clear**.

   A prompt asks you to confirm this.

3) Click **OK**.

   Both the image file and the data (source) file are removed from the datasheet.

**Attaching files to a calculation or reference sheet**

The Calculation and Reference datasheets can have a number of external files attached to them. For a Calculation sheet this might typically be Excel spreadsheets detailing a
A particular calculation or a calculation sheet produced using the PEL Capre application. For a Reference sheet this could be an API specification.

You can attach up to six external files to a Calculation sheet and 18 files to a Reference sheet.

**Uploading calculation files**

*To upload the calculation files:*

1) In the Calculation datasheet, click the first available **Choose file** button, navigate to the calculation file and click **Open**.

2) Then click the **Upload** button.

   A link for the attached file appears in the datasheet.

**Downloading an attachment file**

*To download an attachment file:*

1) Click the attachment file link.

2) In the message dialog, do one of:
   - Click **Open** to open the file.
   - Click **Save** to save the file to disk.

**Deleting an attachment file**

*To delete an attachment:*

1) Click the **Delete** button next to the attachment you want to delete.

   A prompt asks you if you want to delete the item.

2) Click **OK**.

   The attachment is removed from the Calculation sheet.
Linking datasheets

ProvueDB.Net lets you add links between datasheets. This is done by adding the link on the navigation pane to the datasheet that is open. This could be used, for example, to link the Design Basis sheet of a new pump to the equivalent sheet of an existing pump. You could also use the feature to link an item of equipment to a calculation sheet.

Adding a link between datasheets

To link two datasheets:

1) Open either of the datasheets that you want to link.
2) In the navigation pane, expand the tree view to find the other datasheet.
3) Right-click the datasheet and click Link to open sheet.

A link symbol and a hyperlink, Links, appears in the workflow area at the top of the datasheet.

Managing datasheet links

The links dialog for a datasheet with links lets you manage the one or more links you have added. You can jump to the linked sheet or you can remove the links.

To view the links dialog:

- On the datasheet (in the workflow area) click the Links hyperlink.
  The Links dialog opens.

To jump to a link:

- Click the Open hyperlink next to the datasheet you want to go to.
  The linked datasheet opens.
To remove a link

- Click Remove link next to the datasheet you want to unlink.
  If this is the last link, the link symbol is removed from the workflow area of the datasheet.

To close the Links dialog

- Click the Close (X) button in the top right corner.

Printing datasheets

These features let you print one or more datasheets to a PDF file, which you can then save and/or send to your local printer.

**Note** You need Adobe Reader (version 8.x or later) installed on your computer to open PDF files.

Printing a single datasheet

**To print a single datasheet:**

1) Do one of:
   - In the Datasheet tab, click the Print button.
   - In the navigation pane, right click the datasheet you want and click Print to PDF.

   The datasheet is downloaded as a PDF file. This either opens within a new browser window or opens in the stand alone Adobe Reader.

2) Save or Print the file as required.

**Note** The (Internet) preferences in Adobe Reader on your computer determine whether a PDF file opens in the browser window or not.

Printing all datasheets

**To print all datasheets:**

1) In the navigation pane, right click equipment instance node and click Print all to PDF.

   The datasheets are downloaded as a PDF file. This either opens within a new browser window or opens in the stand alone Adobe Reader.

2) Save or Print the file as required.

**Note** The (Internet) preferences in Adobe Reader on your computer determine whether a PDF file opens in the browser window or not.
Chapter 8 – Managing equipment lists

Equipment lists provide a speedy way of adding multiple equipment items and datasheets to your database. Instead of completing all values on each sheet individually, you create a specification that defines a set of the most common parameters on the most common equipment items spread over several datasheets. The specification in turn generates a spreadsheet view of your database, letting you add equipment items by adding a row to the spreadsheet.

Managing equipment list specifications

Creating a specification

To create a new specification:
1) In the Open row, click <Create new> in the dropdown list.
2) In the Specification name field, enter a name for the specification file and click OK.
3) Under Equipment Type / Datasheets, click an equipment type in the list.
   The available datasheets for the equipment type appears in the pane on the right.
4) In the list of datasheets, click a datasheet.
   The datasheet opens in the large pane on the right side of the window.
5) In the datasheet, click the fields you want to add to your specification.
   Each field you click is added to the Selected fields table.

6) If you want to remove a field from the table, click the bin icon at the end of the row. A prompt will ask you to confirm this. Click OK.
7) If required, enter a more meaningful Column Name for each field. This will help you when you use the spreadsheet view to add equipment items to the database.
8) Under Selected Projects/Plants, select the one or more projects/plants you want to use the specification with.
   The specification file is now ready to be used to add or view items in the database.
Opening and/or editing an existing specification

To open an existing specification:

- In the **Open** row, click the specification you want in the list.

  The specification opens.

**Note**  If the specification was created by another user and then published, the source specification will open as read-only. To edit the specification use the **Copy To** field to save a copy of the specification under your own user identity.

To edit an existing specification:

1) In the **Open** row, click the specification you want in the list.

2) Under **Equipment Type / Datasheets**, click an equipment type in the list and in the list of datasheets on the right, click a datasheet.

   The datasheet opens in the datasheet pane on the right side of the window.

3) In the datasheet, click any fields you want to add to your specification.

   Each field you click is added to the **Selected fields** table.

4) If you want to remove a field from the table, click the bin icon at the end of the row. A prompt will ask you to confirm this. Click **OK**.

5) If required, enter a more meaningful **Column Name** for each field. This will help you when you use the spreadsheet view to add equipment items to the database.

6) Under **Selected Projects/Plants**, change the projects/plants you want to use the specification with, if required.

   The specification file is now ready to be used to add or view items in the database.

Renaming a specification

To rename a specification:

1) In the **Open** row, click the specification you want in the list.

   The specification opens.

2) In the **Rename to** field, enter a new name for the specification file and click **OK**.

Copying a specification

This feature lets you create a copy of a specification as a basis for a new specification. If the source specification was created by another user and then published, the source
specification will appear as read-only. Copying the specification to your own user identity gives you write access to change the specification.

**To copy a specification:**

1) In the **Open** row, click the source specification in the list.
   - The specification opens. If the specification is owned by another user it appears as read-only.

2) In the **Copy to** field, enter a name for the new specification file and click **OK**.

**Publishing a specification**

This feature lets you make your specification available to all other users with access to the current database.

**To publish a specification:**

1) In the **Open** row, click the specification you want in the list.
   - The specification opens.

2) Select the **Visible to all users** checkbox.

**Deleting a specification**

**To delete a specification:**

1) In the **Open** row, click the specification you want in the list.
   - The specification opens.

2) Click **Delete Specification**.
   - A prompt will ask you to confirm this.

3) Click **OK**.

**Using an equipment list spreadsheet**

Once you have created an equipment list specification, you can use the specification in either of the following ways:

- **Creating equipment** – the spreadsheet lets you add equipment items to your plant/project, setting specific values as you do so. This is particular useful when setting up the equipment schedule at the start of a project.

- **Running reports** – you can create specification that pick out particular fields for all your plant items of a particular type. For example, you could use this to check the operating temperature and pressure settings are consistent across the plant. The spreadsheet can be output to a CSV file for opening in a standard spreadsheet application, such as Microsoft Office Excel.
Creating equipment from an equipment list

To create an equipment item from an equipment list:

1) Create a new specification or open and/or modify an existing one.
2) Click **Show Results**.
   
The spreadsheet view opens.

```
<table>
<thead>
<tr>
<th>Project</th>
<th>Plant</th>
<th>Name</th>
<th>Type</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEST PROJECT</td>
<td>TEST PROCESS PLANT</td>
<td>P001</td>
<td>PUMP</td>
<td></td>
</tr>
<tr>
<td>TEST PROJECT</td>
<td>TEST PROCESS PLANT</td>
<td>A002</td>
<td>ACTUATED VALVE</td>
<td></td>
</tr>
</tbody>
</table>
```

Current items appear at the top of the spreadsheet, with a row for adding new items at the bottom.

3) Specify each item of equipment by completing the fields along the row:
   
   **Project, Plant** If the specification contains only one project/plant, these fields will be preset.

   **Name** Enter the name for the equipment item.

   **Type** Click the equipment type in the list

   **Title** Enter an optional title.

   **<data field>** Enter values for the various data fields in the specification.

   Only the fields for the equipment type will be available. The values appear in red as you type them.

4) Click **Save Changes** to add the data to the database.

   The saved equipment item is added to the upper part of the spreadsheet with the values in blue.

5) Continue adding equipment items as required.

Reporting on equipment items from an equipment list

To run an equipment item report:

1) Create a new specification or open and/or modify an existing one.
2) Click **Show Results**.
   
The spreadsheet view opens listing all the equipment items that match your specification.

3) Click **Download table as CSV file**.
4) Do one of:
   
   - Click **Open** to open the file in your default program for opening CSV files.
If you have Microsoft Office installed the default application for viewing CSV files is Excel.

- Click **Save** to save the file to your computer or to a network drive.
Chapter 9 – Administrator facilities

A number of facilities within ProvueDB.Net are only available to users with Project Administrator (PJA) privileges. Some of these features, such as defining the units and adding a branding image for your datasheets, are only used at the start of a project. Others, such as the ability to add projects and plants and to set up users need to be restricted to a limited number of privileged users.

Project Administrator (PJA) privileges are assigned to the required users on the User Setup dialogs. The privileges let the user access the Admin tab, which remains unavailable to other users.

Activating Project Administrator (PJA) privileges

The administrator facilities are disabled when an administrator initially logs on and must be activated before they can be used. This protects not just the facilities that are accessed on the Admin tab, but also the controls to create a project and/or plant that become available on the navigation pane.

The lock icon on the Admin tab view shows whether the privileges are active. If the lock is closed the other features are unavailable.

To grant PJA privileges:
1) In the main pane open the Admin tab.
2) Click Grant PJA.

The lock icon changes to open and the other feature buttons are now available. A PJA Active warning appears to the right of the tabs.

To disable PJA privileges:
- In the Admin tab, click Disable PJA.
Defining the units for datasheets

This administrator facility is used to define the units to be printed on the data sheets. This would normally just be specified at the start of a project.

**Note** You need to grant the PJA privileges before you can access this feature.

**To configure the units:**

1) In the main pane open the **Admin** tab.
2) Click **Display Units**.

For each parameter (generic unit) in the list the dialog shows the current unit.

3) To change the units for a particular parameter do one of:
   - Click the unit you require in the **New Unit** list.
   - Type the unit in the **User Unit** box, if available.

4) Repeat for each value you want to change.
5) When you have finished your changes, click **Save**.
   A prompt asks you if you to confirm the change(s).
6) Click **OK**.
   The **Current Unit** list is updated with the changed values.
Managing users

These administrator facilities let you add, modify or delete users from the system. Users are created in a particular database, so if you use more than one database the user will need to be created in each.

Note You need to grant the PJA privileges before you can access this feature.

Listing users

To view the current list of users:

1) In the main pane open the Admin tab.
2) Click User Setup.

Note that the desktop edition of ProvueDB.Net doesn’t have access to email. The dialog contains commands to let you Add, Edit or Delete a user.

Adding a user

This lets you set up the access details for a user.

To add a user:

1) With the user list in view, click Add New User.
2) Enter the details as required:
   Provue Name Enter the Provue name (this is both the login identifier for your database and the name that appears on datasheets).
   Password A random password for the user is created. You can change this if you want.
**Provue group**  Select a group (the default is A).

3) Select the group of users whose data sheets the new user can check and/or approve by entering their group letters in the Check Groups and Approve Groups boxes (leave these boxes blank if the user cannot check or approve).

4) If you want the user to have **Project Administrator** access rights, select the checkbox.

5) Click **Save User Details**.
   A pop-up message appears, showing the success (or otherwise) of the command.

6) If required, you can add several users while the dialog is open. You will need to specify a unique user name and email address for each user.

7) When you have finished, click **Close** to return to the list of users.

### Modifying a user

This lets you change the access details for a user.

**To modify a user:**

1) With the user list in view, select the user in the list and click **Edit User**.

![User Setup](image)

2) Change the **User Details** as required.
   By default users are given full access rights when they are added to the system. You can restrict access either globally or for each project/plant.

3) To change the access rights globally (for all projects/plants) click one of:

   - **Set Full Access**  User has full read/write access (default setting for new users).
   - **Set Read Only**  User has read access.
   - **Set No Access**  User has no access rights.
4) To change the access rights for one or more individual projects/plants click the required option for each project/plant.

5) Click **Save User Details**.
   
   A pop-up message appears, showing the success (or otherwise) of the command.

6) Click **Close** to return to the list of users.

### Deleting a user

To delete a user:

1) With the user list in view, select the user in the list and click **Delete User**.

   A prompt asks you if you want to delete the selected item.

2) Click **OK**.

   The item is removed from the list of users.

**Note**  Deleting a user will stop the user from connecting to this database using ProvueDB.Net.

### Managing projects and plants

These administrator facilities let you add, rename or delete projects and plants from the system.

**Note** You need to grant the PJA privileges before you can access these features.

#### Creating a new project/plant

The database consists of a number of projects and plants under which items of equipment are added. A project can be associated with one or more plants and a plant can be associated with one or more projects. In the ProvueDB.Net navigation pane you can show either projects or plants as the top level.

**Note** For simplicity the following instructions are in the default arrangement (project at the top).

**To add a new project:**

1) In the navigation pane, right click the top node and click **New Project**.

   ![New Project button](image)

2) In the dialog box, enter a **Name** and an optional **Title** and click **OK**.

   A new project node is added in the navigation pane.

**To add a new plant:**

1) In the navigation pane, right click the project node and click **New Plant**.
2) In the dialog box, enter the **Plant Name** and an optional **Location** and **Works** descriptions, and then click **OK**.

A new (secondary) plant node is added in the navigation pane.

**Renaming a project/plant**

**To rename a project:**

1) In the navigation pane, right click the project node and click **Rename Project**.
2) In the dialog box, change the **Name** and/or **Title** as required, and then click **OK**.

**To rename a plant:**

1) In the navigation pane, right click the plant node and click **Rename Plant**.
2) In the dialog box, change the **Plant Name** and/or the **Location** and **Works** descriptions as required, and then click **OK**.

**Deleting a project/plant**

**To delete a project:**

1) In the navigation pane, right click the project node and click **Delete Project**.

   A prompt warns you that plants, equipment and datasheets under this node will be lost if you delete the project.

2) Click **OK**.

   The project (and any plant, equipment and datasheets under it) is removed from the navigation pane.

**To delete a plant:**

1) In the navigation pane, right click the plant node and click **Delete Plant**.

   A prompt warns you that equipment and datasheets under this node will be lost if you delete the plant.

2) Click **OK**.

   The plant (and any equipment and datasheets under it) is removed from the navigation pane.
Copy data between databases

This administrator facility lets you copy data between the databases you are connected to. This could, for example, allow you to replicate data from a previous project, or allow you to create your datasheets in a development or test database and then copy the issued data to a ‘live’ database when the equipment is installed.

**Note** You need to grant the PJA privileges before you can access this feature.

**To copy data between databases:**

1) In the main pane open the **Admin** tab.
2) Click **Database Transfer**.

3) Under **Source Database**, select the database containing the source data in the dropdown list.
4) In the list of projects/plants that appears in the pane below, select the relevant project/plant.
5) Under **Target Database**, select the database and then the project/plant to copy the information.
6) Under Source Equipment List, select the one or more items of equipment to copy and click **Add to Copy List**. You can use Ctrl-Click and Shift-click to select multiple items in the list.

   The items are added to the **Transfer List** on the right. You can repeat this step to compile your transfer list. You can also select multiple items in the transfer list and click remove to **Remove** items from the list.

7) At the top of the form specify what to do if there is a mismatch between the units in the source and the target databases.
8) Finally click **Transfer** to copy the data.

   A message appears in the window indicating the success of the transfer.

9) Click the link to return to the transfer dialog and then click **Cancel** to close the window.
Clearing equipment locks

When a user fetches an equipment item, opens a signed off item for checking, or opens a checked item for approval, the item is locked to prevent other users from writing to the datasheets. In some circumstances, such as the web browser terminating suddenly, these locks can remain preventing the approval cycle from continuing. This feature lets a system administrator clear these locks.

**Note** You need to grant the PJA privileges before you can access this feature.

**To clear any equipment locks:**
1) In the main pane open the Admin tab.
2) Click **Clear Equipment Locks**.
   A prompt asks you to confirm the command.
3) Click **OK**.

Changing the equipment revision sequence

The revision sequence controls how revision numbers for datasheets can change. When a data sheet for an item of equipment is first created its status is **Development**. After it has been **Checked** and **Approved** it can then be issued. If the datasheet needs to be modified, it can be reissued. Each issue will be designated A, B, C, etc. The initial issue may go through several iterations before its first issue, so these are designated A1, A2, etc. Subsequent revision may not require these secondary numbers. This is expressed in the format:

A9B0C0

This allows A1, A2 up to A9, then B, C, and so on.

A possible example of needing to change the sequence would be if you wanted to avoid using the letters I and O if they cannot be distinguished from numbers 1 and 0 in your chosen font.

**Note** You need to grant the PJA privileges before you can access this feature.

**To change the equipment revision sequence:**
1) In the main pane open the Admin tab.
2) Under **Equipment Revision Sequence**, click **Change** to make the sequence available.
3) Change the sequence as required and click **Submit**.
   A pop-up message appears, showing the success (or otherwise) of the command.
4) Click **OK**.
Customising the datasheet logo

By default ProvueDB.Net creates datasheets containing the ABB logo in the top left corner. This can be easily replaced with the logo or other branding graphic for your own organisation.

**Note** You need to grant the PJA privileges before you can access this feature.

**To upload a branding graphic:**

1) In the main pane open the **Admin** tab.

2) Under **Datasheet logo**, click **Browse** to navigate to the graphic file and then click **Upload File**.

The new logo will replace the ABB logo on the page.

Hiding datasheets

This feature lets an administrator restrict groups of users from seeing specific datasheets in a set. For example, if some of the datasheets are to be completed by external contractors, you may wish them only to see the sheets they are to complete.

**Note** Before you can hide sheets in this way, you must have created your external users in one (or more) different groups.

**To hide a sheet from a group of users:**

1) In the navigation pane, right click the datasheet you want to restrict and click **Hide/Unhide**.

2) Select the group you want to restrict in the list and then click **Add Group**.

The group is added to the pane on the left, with the users in that group appearing in the pane on the right.

3) Click **Close Window**.
The datasheet is now marked with a restricted (no entry) symbol in the navigation pane.

To unhide a sheet from a group of users:

1) In the navigation pane, right click the datasheet you want to restrict and click Hide/Unhide.

2) In the left pane, select the group you no longer want to restrict and click Remove Group.

The group is removed from the left pane together with the restricted users in the pane on the right.
Revision history

The following table records the revision history of this guide.

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Description of change</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>19 Oct 2012</td>
<td>Guide written for PEL release 19.5</td>
</tr>
<tr>
<td>1.1</td>
<td>25 Jan 2013</td>
<td>Workflow and Hide/Unhide added. Minor screenshot changes.</td>
</tr>
<tr>
<td>2.1</td>
<td>28 Nov 2016</td>
<td>Minor changes for software version 3.2</td>
</tr>
<tr>
<td>2.2</td>
<td>3 April 2017</td>
<td>Login changes for desktop version 3.2</td>
</tr>
</tbody>
</table>
60 Second Guide
A short self-paced tutorial that takes you through the main features of a PEL application.

CSV file
A Comma-separated values file stores tabular data in plain text form.

SQLite
SQLite is a software library that implements a self-contained, SQL database engine. Unlike many database systems, SQLite is not a client-server database engine, but is embedded in the end program, which makes it ideal for use with web browsers.
A
- Adding a calculation or reference sheet 33
- Adding a datasheet 31
- Adding a link between datasheets 43
- Adding a user 53
- Adding new equipment 29
- Approving an item of equipment for issue 37
- Attachment files
  - deleting 42
  - downloading 42
- Changing the equipment revision sequence 58
- Checking an item of equipment 36
- Clearing equipment locks 58
- Clearing the current sketch files 41
- Closing a datasheet 32
- Converting units and values 38
- Copying a datasheet 32
- Copying a specification 47
- Creating a new project/plant 55
- Creating a specification 45
- Creating equipment from an equipment list 48
- Customising the datasheet logo 59

C
- Changing the equipment revision sequence 58
- Checking an item of equipment 36
- Clearing equipment locks 58
- Clearing the current sketch files 41
- Closing a datasheet 32
- Converting units and values 38
- Copying a datasheet 32
- Copying a specification 47
- Creating a new project/plant 55
- Creating a specification 45
- Creating equipment from an equipment list 48
- Customising the datasheet logo 59

D
- Datasheet logo, changing 59
- Datasheet tab 10
- Datasheet workflow 25
- Datasheets
  - adding 31
  - closing 32
  - copying 32
  - deleting 32
  - hiding 59
  - printing 44
  - workflow 25
- Defining the units for datasheets 52
- Deleting a datasheet 32
- Deleting a project/plant 56
- Deleting a specification 47
- Deleting a user 55
- Deleting an attachment file 42
- Deleting equipment 31
- Downloading an attachment file 42
- Downloading the current sketch files 41
- Downloading the Word description file 40

E
- Entering a description field in text mode 39
- Entering data fields 37
- Entering data fields involving a calculation 38
- Equipment
  - adding 29
  - approving for issue 37
  - deleting 31
  - fetching an item of 35
  - renaming 30
  - replicating 30
  - signing off an item of 36
- Equipment locks, clearing 58
- Equipment ownership 27

F
- Fetching an item for editing 35
- Find tab 9

G
- Groups, using 27

L
- Listing users 53

M
- Managing datasheet links 43
- Modifying a user 54

N
- Navigation pane – controls 7

O
- Online documentation 12
- Online help 12
- Opening an existing datasheet 31
- Opening and/or editing an existing specification 46

P
- PEL Support Services 12
- Printing a single datasheet 44
- Printing all datasheets 44
- Publishing a specification 47
R
Renaming a project/plant 56
Renaming a specification 46
Renaming equipment 30
Renaming, Replicating or Deleting a document 34
Replicating equipment 30
Reporting on equipment items from an equipment list 48
revision sequence, changing 58

S
Signing off an item of equipment 36
Sketch datasheet
clearing 41
downloading 41
uploading files 40
Specification, equipment list
copying 47
creating 45
deleting 47
opening 46
publishing 47
renaming 46
Starting ProvueDB.Net Desktop Edition 5
Status tab 8

T
The approval process 27
Tools tab 10
Transferring an item 36

U
Units
converting 38
defining for datasheets 52
Uploading a description field from Word 39
Uploading calculation files 42
Uploading the sketch files 40
Users
adding 53
deleting 55
modifying 54
Using groups 27

V
Viewing previous versions of data fields 38